DIRECT CERTIFICATION/
DIRECT VERIFICATION

CE IMPORT
FOR CE LEVEL MATCHES



OVERVIEW

Direct Certification is a simplified method of determining student’s eligibility for free meals through the
National School Lunch and School Breakfast Programs or free milk under the Special Milk Program without
completing a Household Eligibility Application. In addition, students directly certified to receive free meals or
milk are not subject to verification.

BENEFITS OF THE DIRECT CERTIFICATION PROCESS:

SAVES EMPLOYEE’S TIME AND REDUCES PAPERWORK!!

Any student who has been directly certified does not have to fill
out a paper application and does not have to go through the
verification process

IDENTIFIES ELIGIBLE STUDENTS QUICKLY!

This process may identify eligible students whose
household did not complete the paper application.
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HHSC sends list of all children in the
state ages 3 to 21 whose families are
receiving benefits.

Health & Human
Services

Commission

TEA compares this list to enroliment
data and “matches” students to the
school district.

Texas Education
Agency

TDA posts the updated matched and un- Texas De_partment
matched data monthly of Agriculture

Contracting Entity

The CE monitors the State Match
List and uses the CE Matching
Process to determine if students
are eligible for meal benefits. Any
student “matched” in the system
does not have to complete an
application for benefits.
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CE prepares file with student data for upload

CE logs into TX-UNPS and selects Direct Certification/Direct Verification screen

CE selects CE Match process

CE uploads data file

System returns file of eligibility records matched to CE's data file

CE saves matched file and prints copy for records

CE notes in records (POS system) students that are directly certified for benefits
-- noting category of eligibility

®
\—\elp‘fﬂ\
ips
i IF YOU HAVE CHANGED YOUR TX-UNPS PASSWORD TODAY YOU CANNOT

ACCESS THE SYSTEM UNTIL TOMORROW.

%
Helpful
Tips . . . . . . .
After an extended period of inactivity the system will “kick you out” and may display an unauthorized

use message. If you get this message click on “EXIT” in the top right corner and log back on.

%
\—\e|pfu\
Tips
PLEASE NOTE: the screen shots in this guide were taken while using the Internet Explorer 9 browser.

Your screens may or may not look exactly as the ones in this guide if you are using a different browser (i.e.
Mozilla Foxfire, Google Chrome, Safari, etc.).
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MAKE FILE FOLDERS

It is easier if you determine where you want to store the Direct Certification files before you start the
process. The most efficient method will be to create a Direct Certification folder and inside of that folder
create a folder for the school year.

1. Inthe MY DOCUMENTS window, right click and choose NEW > FOLDER.
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2. Name the folder DIRECT_CERTIFICATION_DATA.

%
\—\e|p’fU\
Tips

(-) or capital letters to take place of spaces between words.)

Files are more easily corrupted if there are spaces in the file name. Use the underscore (), hypen

E;;v@ b Libraries » Documents »

Organize = & Open Share with = E-mail Burn Mew folder
7 Favorites Documents library
B Desktop Includes: 2 locations
% Downloads Mame . Date modified Type Size
. Program Improvement & Policy
\E"'_".‘ Recent Places My Data Sources 5/21/2014 5:40 PM File folder
RealPlayer Cloud . My Received Files 7/2/2014 1:41 PM File folder
Ji H My Documents @ My Shapes 3/19/2014 12:08 PM  File folder
Ji TX-UNPS Enhancements | J | Direct Certification Data 8/6/2014 9:50 AM File folder
| Files_for_DSS . OneNote Notebooks 4/10/2014 7:19 AM File folder
= Libraries . Outlook Files 8/6/2014 9:16 AM File folder
| Remote Assistance Logs 8/4/2014 1:43 PM File folder
= Libraries
@ Documents
Azi Music
[E5] Pictures
i Videos

3. Inside of that folder, right click to make another New Folder. Name it DC- followed by the current school

year.

4. Inside of this folder, make 2 more — one for DC_Lists and another for DC_Data.

e

Organize v Include in ibrary v

W Favorites

M Desktop

& Downloads

10 Program Improvement & Policy
L. Recent Places
RealPlayer Cloud

J HMy Documents

1. TX-UNPS Enhancements

|, Files_for DSS

4 Libraries

Sharewth v Bum  Newfolder

F

"

J» DC2014-2015

v‘ i » Computer » Local Disk (C:) » Users » Idumas » MyDocuments » Direct Certification »

Date modified

8/5/2014 1:02 PM

Type

File folder
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o |[@][=

W Favorites
Bl Desktop
& Downloads
J. Program Improvement & Policy
1 Recent Places
RealPlayer Cloud
. HMy Documnents
i TX-UNPS Enhancemnents
). Files_for_DSS
1 VerficationRepart
A Libraries
- Libraries
“| Documnents
& Music
= Pictures
B Videos

M Computer
-~

' 2 items

Organize » Share with + Bum New folder

Documents library
DC_2014-2015

Arrange by:

Date medified Type Size
9/19/2014 245PM  File folder
9/19/2014 244 PM  File folder

|- ¥ Libraries » Documents » Direct Certification Data » DC_2014-2015 » x| +2 W Search DC_2014-2015 =l

e @

Folder =

%
He\p‘fu\
Tips

Note: You will need to make the Direct Certification Data folder just once. Make a new DC-(school

year) folder each August to start the new school year.

%
Helpful
Tips

Make a note of where on your computer you saved the folder so that it is easy to find when you
need to access it later in the process.

" — -

Organze v Includeinlibrary v Sharewith v Bum

e e

mv' I » Computer » Local Disk (C:) » Users » Idumas § My Documents »

Direct Certification »

Folder Location

Your document
voe
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PREPARE CSV FILE FOR UPLOAD

The data must be a comma delimited file (CSV). A CSV file can be made in any version of Excel.

e Your POS system may have an option for generating a file with the necessary data

e If you have access to PEIMS data (public and charter schools), contact the PEIMS clerk for your
district/school and have them pull the information from PEIMS as a .csv file (or Excel file if they cannot
do a .csv file type. The file must be formatted as described in Step 2.

1. Create a new file in Excel.

ook - McosrkExd
2. Format cells as B
Text”. T T T TR : ’ﬂ ﬁg?
Click the box » 0 A EET FF Bepatenr 0% 93 ;ﬁ;:;‘:?ﬂ. et
in the upper R - fot . — :
left corner to
select the
entire
worksheet.

Right -- click and

2% Cut
“ Ean copy

@ Ly
Cells”.

Paste Special...

Insert

Delete

= =
I 5 Format Cells... I

-= =
Hide
Unhide
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" N Format Cells | E | ——
Select “Text” and

Number | Alignment I Font I Border I Fill IProtection

then select OK.
Category:

General - Sample
Murmber
Currency
Accounting Text format cells are treated as text even when a number is in the cell.

Date The cell is displayed exactly as entered.
Time

Percentage

I Sdentific

Text

Special
ustom

Ok l [ Cancel

3. Set up the file with these columns in the same order and format.
Do not include header labels for the columns.
Column A: Social Security Number

9 digits (numbers); no dashes
Include leading zeros
Column B: Last Name
Column C: First Name
Column D: Birth Date
mm/dd/yyyy
Must be digits(numbers) — not letters
Must include leading zeros in month and day
Column E: Gender (F, M)

6™ Column — If you can pull eco eligibility information from PEIMS, it will be in this column. It will show
the students that are already directly certified. Delete all previously identified students off this list before
proceeding.

If this information cannot be pulled from PEIMS, skip this column. This column will be deleted before
uploading the file.

Column F: CE ID

5 digits (numbers)

Include leading zeros

A B E D E F

1 /777889999 Doe John 10/11/2013 M 00234
7 (999887777 Doe lane 11/10/2013 F 0234
3
4
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4. When completed, save as and select “CSV (Comma delimited) (*.csv)” from the file type drop-down box.

Select File> Save as

Use the drop-down for File name: DCFileUpload_CE00234 131016

Save as type: [Eucel Workbook (*.xlsx) -

Excel Workbook (*adsx)

select “ Comma Excel Macro-Enabled Workbook (*.xlsm)
Excel Binary Workbook (*.xlsh)

Separated Values” Excel 97-2003 Warkbaak (%.xls)
XML Data (*aml)

Single File Web Page (*.mht;*.mhtml)
= Hide Folders Web Page (*.htm;*.html)
Excel Template (*.xltx)
e Excel Macro-Enabled Template (*xitm)
Excel 97-2003 Template (*.xit)
Tesxt (Tab delimited) (*.bd)
Unicode Texdt (*.bt)

“Save as Type” and
Authors:

Microsoft Excel 5.0,/95 Warkbook (%.xls)
CSV (Comma delimited) (*.csv)
Formatted Text (Space delimited) (*.prn)
E S il

Check the CSV file in a text editor such as Notepad or WordPad instead of Excel. This will show leading

zeros. Your example should look like this:

Jj DCFileUpload_CE00234_131016 - Notepad

File Edit Format View Help

777889999 ,Doe,John,10/11,/2013 ,mM,00234
999887777 ,Doe,Jane,11/10,/2013,F,00234
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CE IMPORT FOR CE LEVEL MATCHES

Log-in to TX-UNPS.

Go to School Nutrition Programs > Applications > Direct Certification/Direct Verification

TX-UNPS Sz

2Z Programs | vear | Help | Logout

School Nutrition Programs

Applications | Claims | Compliance | Reports | Security | Search

Programs

22 Programs | r| Help | Logout
Applications > School Year: 2014 - 2015
Item Description
Contracting Entity Manager SMP Contracting Entity's Profile, Site and Hold Information
Application Packet Applications Forms (Contracting Entity and Site)
Meal Pattern Compliance Summary Mumber of Menu Pattern Certifications by Contracting Entity Summary
Verification Report Mandatory Annual Verification Report
Verification Summary Mandatory Annual Verification Report (FNS-742) Summary
Food Safety Inspections Number of Food Safety Inspections by Site
Food Safety Inspections Summary Number of Food Safety Inspections by Site Summary
Annual Audits Annual Audits
Annual Audit Status Summary Annual Single Audit Status Summary
Financial Report School Food Annual Revenues and Expenditures Report
Financial Report Summary School Food Annual Revenues and Expenditures Report Summary
FFVP Grants Fresh Fruit and Vegetable Program Grant Information for a specific CE
FFVP Grant Overview Fresh Fruit and Vegetable Program Grant Information by Site Overview
FFVP Grant Allocations Fresh Fruit and Vegetable Program Grant Allocations by CE/Site
FFVP Summary Fresh Fruit and Vegetable Program Invitations and Approvals
Summer Nutrition Program Costs Total Costs Associated with Operating 8 Summer Nutrition Frogram
Capital Expenditure Request Request for funds to purchase capital items = 5,000
October Enrollment October Enrollment and Eligibility by Site
Site Enrollment Site Enrollment and Eligibility
Community Eligibility Provision Enrollment and Eligibility for Community Eligibility Provision
Texas Summer Mandate Summer Nutrition Programs Intent Declaration

Direct Certification / Direct Verification Direct Certification / Direct Verification screens
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Click on Direct Certification/Direct Verification (again)

— - = - - - —_ s - _

School Nutrition Programs

iEPrngrams | ‘v'earl Help | Log Out

Applications Claims Compliance | Reports | Security | Search

School Year: 2014 - 2015

Applications = Direct Certification / Direct Verification =

Direct Certification / Direct Verification

Direct certification (DC) iz a method of directly certifying children who are categorically eligible for free meals
due to the household receiving SNAP (Supplemental Nutrition Assistance Program) or TANF (Temporary
Assistance for Needy Families) benefits. TDA provides updated DC information monthly to assist with the USDA

required DC regulation.

Direct verification is a method of verifying program participation for children who are approved for free or
reduced-price meals using state SMNAP, TANF, CHIP (Children’s Health Insurance Program) and Medicaid records.
TDA provides direct verification information beginning October 1 of each year to assist with the USDA required

verification regulation.

Click on the link below to geo to the Direct Certification/Direct Verification screens. (Note: This will open in a new
=zet to allow pop-ups.)

Direct Certification / Direct Werification

Click on link to verify Direct Certification / direct
Verification )

%
\—\e!pfu\
You will get this message if you have changed your password today or have timed out (been inactive for
a period of time). If you have not changed your password, log-out and log back in and go immediately to Direct
Certification/Direct Verification.

“Unauthorized misuse of TDA information resources is prohibited and misuse is subject to

criminal prosecution. Except as otherwise provided by applicable privacy laws, there should be
no expectation of privacy. Usage may be subject to security testing and monitoring.”

Click on the “Direct
Certification” link (left
of screen on blue
bar).

Texas Hs

Departmént of Agrculture 10,

CLICE QN THE "DIRECT

CERTIFICATION" LIME

L
Helpful
Tips . . . , L
Some users will have to enter a CE ID if they are associated with more than one district.
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Select “CE Import for CE = S——
Level Matches”
Direct Certification - Direct Verification Texas o |

L0V Mome
Coreractirg Enty 1D; 01400 Comracting Entity Name: NEW DOSTON ISD (TEXARKANA 15D) CD Code: DLE305

2.

Direct Cectification Home Pagw

Frire/Daaniosd Orest Carthzaticn Metzoes

SELECT:

[ CCimpar for CE Lesed Matches ||

Seacch Pape far CE Level Matches

"CEIMPORT FOR CE
LEVEL MATCHES"

tie € B3rees 10 Use o Sisdose The indarmation anly for &5 incended purpase, and 1o 1ot e or dschase ay
B for sy perpons ather than far, or In conrection with the swtharized pergote

The Direct Certification CE Import for CE Level Matches Upload File must be a Comma Separated Value (CSV]) file.

Please review the web pages below for further instructions, including a quick guide,
on how to create the CSV file in the correct format needed to do an upload for CE Level Matches.

Contracting Entity ID: 01400 Name: NEW BOSTON ISD (TEXARKANA ISD) CD Code: 019905

CE Import for CE Level Matches

The Direct Certification CE Import for CE Level Matches Upload File must be a Comma Separated Value (CSV) file.

Please review the web pages below for further instructions, including a quick guide,
on how to create the CSV file in the correct format needed to do an upload for CE Level Matches.

+ School Nutrition Programs DC/DV Supplemental Manual

* Quick Guide

Important: Do not exceed 50,000 records or your upload will be rejected.

: Browse...

Upload File
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RESOURCES FOR R REFERENCE

TX-UNPS RESOURCES FOR SCHOOL NUTRITION PROGRAMS

%
\—\e|pr\
Tips
i If pop-up window does not open it means you have the pop-up blocker tool on. Quick fix: Hold down
your control key (Ctrl) and click on link again.

e =% Here you will find links to multiple resources

for School Nutrition Program.
This will open up in another screen. See the
next picture.

Texas B
Department of Agri

Contracting Entl e: NEW BOSTON ISD (TEXARKANA ISD) CD Code: 019905

Import for CE Level Matches

The Direct Certification port for CE Level Matches Upload File must be a Comma Separated Value (CSV) file.

Please review the web pages below for further instructions, including a quick guide,
on how to create the CSV file in the correct format needed to do an upload for CE Level Matches.
——

Important: Do nof ceed 50,000 records or your upload will be rejected.

Browse... |

Upload File

Al ICE Sl Lol vieie e

9/8/2014
o 3 — = [ x
b lliedll > https://testdcdy texasagriculture.gov/DCOV O ~ @ 2 & X || « [inss el >ocov <l ok
S S S = =
Direct Certification ¥Direct Verification I o |

Department of Agriculture &8 8,

Entity Name: NEW B{

e: 019905
5 - wvel Matches H H
@ 145 DerartmenT oF AcmicuLTuRE This will be a separate
[Food and Nutrition Website
TR e e . .
window/screen that will
open up with your main
Pre Txunps | School Nutrition Programs (SNP) Program Resources .
o TR S Usir st screen. You can make it
bigger by click on
R e e o i et oo n—

=]

8:47 AM
9, 4
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SCHOOL NUTRITION PROGRAMS DC/DV SUPPLEMENTAL MANUAL

il = https:/testdcdy texasagriculture.gov/DCDY O ~ @ 2 & X || #] '-'

Texas -

Department of Agriculture

This is a complete user manual for the DC/DV process in
TX-UNPS.
This will open up in another screen. See the next picture.

Contracting El ISD (TEXARKANA 1SD) CD Code: 019905

The Direct Certificatiol Matches Upload File must be a Comma Separated Value (CSV) file.
Please review the web page:

on how to create the CSV file i

Istructions, including a quick guide,
‘mat needed to do an upload for CE Level Matches.

Important: Do not exceed 50,000 records or your upload will be rejected.
—
| Browse... |

Upload File

Texas

Department of Agriculture

*| hitp//wwwsq.. £ ~ & X | x| squaremeals.org % Contracting Entity Name: NEW BOSTON ISD (TEXARKANA 1SD) €D Code: 019505

Level Matches

ad File must be 3 Comma Separated Value (CSV) file.

TEXAS DEPARTMENT OF AGRICULTURE uding a quick guide,
= = = an upload for CE Level Matches.
Texas Unified Nutrition Programs System (TX-UNPS)

rds or your upload will be rejected.

[ Browse... |

School Nutrition Programs

Direct Certification and Direct
Verification (DCDV)

Supplemental Manual

11:06 AM

a  [my o
A 9/8/2014
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This is a Quick Guide-How to make a CSV File

This will open up in another screen. See the next picture.

Matches

ty Name: NEW BOSTON ISD (TEXARKANA ISD)

Texas -
Department of Agriculture &8 8,

CD Code: 019905

Impoiant: Do not exceed 50,000 records or your upload will be rejected.

Browse.

“wrification

Quick Guide — How to Make a CSV File for DC/DV Upload

The data must be a comma delimited file (CSV). A CSV file can be made In any version of Excel
1. Create a new file in Excel.
2. Format cells as “Text" = = =

Click the box In the upper left corner to =

select the entire worksheet i

Right click and select “Format Cells”. ie

Select “Text” and then select OK

N

Contracting Entity Name: NEW BOSTON ISD (TEXARKANA ISD)

br CE Level Matches

hes Upload File must be 8 Comma Separated Value (CSV) file.
ns, including a quick guide,
2d to do an upload for CE Level Matches.

arams

ntal Manual

records or your upload will be rejected.

[ Browse...
Ipload File

exas =2
Department of Agriculture £38,

€D Code: 019505

11:29 AM
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UPLOAD FILE

If your file contains more than 50,000 records, you will need to break it up into smaller files that have
less than 50,000 records. Records of 20,000 have been successfully run in a short period of time.

%
\—\e\pﬁl\
Tips

D R = = M

Tl

Direct Certification - Direct Verification

4
Texas T
Department of Agriculture  §38, I

Contracting Entity ID: 01400 Contracting Entity Name: NEW BOSTON ISD (TEXARKANA ISD) CD Code: 019905

CE Import for CE Level Matches

The Direct Certification CE Import for CE Level Matches Upload File must be a Comma Seperated Value (CSV) file.

Please review the web pages below for further instructions, including a quick guide,
on how to create the CSV file in the correct format needed to do an upload for CE Level Matches.

+ TX-UNPS Resources for School Nutrition Programs

+ School Nutrition Programs DC/DV Supplemental Manual A

) {
* Quick Guide \‘ 3. "

CLICK ON
“BROWSE”
TO SEARCH
FOR YOUR
FILE

—
-

R = B

Direct Certification CE Import Process 18
September 2014



@ Choose File to Upload | =
@’Qv| lJ <« Documents » Direct Certification Data » DC_2014-2015 » DC_Data v ‘4,” Search DC_Data Fe peov ‘ ‘
Organize » New folder = | @
* FND aHDm1 CTest aFind services in your local ...
R Favorites - Documents I\brary Armange by:  Folder * Whel’l yOU CI|Ck on
B Deskiop DC_Data
5 b
1 ownlosds : rT—— .. ct V rifi the Browse
.. Program Improvi i
o Enrollment_data_140922.csv 9/22/201412:30 PM  Microsoft Exc W... 9KB bUtton you WI” see
1. Recent Places @J

this box pop up.
Look for your file USTON 15D
here.

RealPlayer Cloud
' HMy Document
|, TX-UNPS Enhan¢

.. Files_for DSS

»

| VerificationRepor 4
i Libaries Y Click on the file you
i Libraries Want to upload' E Level Matches Upload File must be 8 Comma Separated Value (C5V) file.
@ Documents NeXt CI|Ck on Ope a quick guide,
Jy Music upload for CE Level Matches.
[ Pictures - | Programs

File nan{ Enrollment_dsta_140922.csv emental Manual

Open |v Cancel

Important: Do not exceed 50,000 records or your upload will be rejected.

LY
\—\elp‘fU\
Tips

If you don’t see your file (Folder) make sure you are in the right location, as we covered earlier in this manual.

DCDV/DCimporty £ - @ 2 & % |/¥mma evens Fight Schedie 9] = DCDV x |3
Certification - Direct Verification

—

Direct

[
Texas e
Department of Agriculture £ 88, I

Contracting Entity ID: 01400

Contracting Entity Name: NEW BOSTON ISD (TEXARKANA ISD) CD Code: 019905

CE Import for CE Level Matches

Please review the web pages belo'
on how to create the CSV file in t

m

YOUR FILE WILL NOW BE
SHOWN HERE. NEXT, SELECT
+ School Nutrition Progra “UPLOAD FILE”

Important: Do not exceed 50,000 re fls or your upload will be rejected.

I C:\Users\hvalin\Desktop\DIRECT CERT 2014\dc testing.csv I [ Browse... |

zs00M ||
o/5/2014

s
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SAVE THE FILE

. gov/DCDV/DCimporty L-aBceXx @ pcov L ok It

Direct Certification - Direct Verification Texas e
Department of Agriculture &3 8, |

Contracting Entity ID: 01400 Contracting Entity Name: NEW BOSTON ISD (TEXARKANA ISD) CD Code: 019905

CE Import for CE Level Matches

The Direct Certification CE Import for CE Level Matches Upload File must be a Comma Separated Value (CSV) file.

Please review the web pages below for further instructions, including a quick guide,
on how to create the CSV file in the correct format needed to do an upload for CE Level Matches.

After a successful upload, you will receive
this message at the bottom of the page.

¢ School Nutrition Pr

¢ Quick Guide

Important: Do not exceed 50,00 § or your upload will be rejected.

S 416PM
- 9/5/2014

s B ST

AR

Doyouwant to open or save D_TDA_TEST CNPIMS Impart Save Results ARUSSELL 9 5 20144 16 36 PM.csv from testdcdv.texasagriculture.gov?

Open Save |7 Cancel

%
He\p‘ﬂl\
Tips . o . I , ,
When this message appears, it is a good habit to save the file first then open it. That way you will not
forget to save it. Remember to save this document to your DC folder.

%
He\pﬁl\
Tips
i When saving the file it is a good idea to use the date in the name of the file so it will be easy to find on
the future. EX: DC_Upload_Match_140715 ( for:July, 15, 2014)
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» DIRECT CERT 2014

New folder

Organize ~

7 Favorites
I Deskiop
b Dovnloads

< Recent Places

[ Libraries
%, Documents
\'1 Music
&, Pictures

& Videos

& Computer
& Local Disk (C)

 applications (\\A02) (G)
< hvalin (\\a02\home) (H:)

< FND (\\A02) (S))
RealPlayer Cloud

% Network

Name Date modified Type
@ dcfile 2 9/5/2014 448 PM  Microsoft Fxcel Co... 1KB
2 detesting Microsoft Excel Co... TKB

< public Nad agrstate tuus) (P) This will open up a “Save As” task box.
Next, type your file name in the File
Name box. Next. select “Save”

F\Iename:l DC Ubload

Save as type:

Match 140715

* Hide Folders

CD Code: 019905

Contracting Entity ID: 01400

Direct Certification - Direct Verification

Contracting Entity Name: NEW BOSTON ISD (TEXARKANA ISD)

CE Import for CE Level Matches

The Direct Certification CE Import for CE Level Matches Upload File must be a Comma Separated Value (CSV) file.

Please review the web pages below for further instructions, including a quick guide,
on how to create the CSV file in the correct format needed to do an upload for CE Level Matches.

* TX-UNPS Resources for School Nutrition Programs

* School Nutrition Programs DV Supplemental Manual

o .

Select “Save As”

Important: Do not exceed 50,000 recol

C:\Users\hvalin\Desktop\DIRECT CERT 2014\dc testi
Upload File

Do you want to open or save D_TDA_TEST_CNPIMS Import Sa: csv from testdcdv.texasagricy Save
Save as
Open Save | ¥ Save and open

T WMe BETRT D

") N
Texas W
Department of Agriculture §3 8,

CD Code: 019905

10:19 AM
S roe ]

014
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PASSWORD PROTECTING FILES
Hek’f‘“ Since these files will have sensitive information (SSN, D.O.B, etc.) you need to password
Tips  protect your files.

IDENTIFY EXCEL VERSION

The instructions for working with Excel differ based on the version of Microsoft Office that you have.
You may be able to determine what version of Microsoft Office you have by looking at the Start Menu.
If not, the following information may help you determine wich set of instructions to use. Please note:
The pictures are from Word, but the same steps apply to Excel.

, _ E (T B Adobe Acrobat Distiller XI
Click on the Microsoft Gem or 7 on the bottom left
) Windows Fax and Scan
9 Windows Media Center

to open the Start Menu. i—" Adobe Acrobat A1 Fro
# Adcobe FormsCentral
ﬂ Adobe Reader X1
Eﬁ Apple Software Update
@ Default Programs
it/ Desktop Gadget Gallery
= Internet Explorer (64-bit)
= Internet Explorer
§| Windows Media Player

| Windows DVD Maker

E_T Windows Update

KPS Viewer

W I-Zip

| Accessories

| CnpXpress

| CutePDF

. Google Chrome

. lava

., Maintenance

. Mchfee

. Microsoft Lync

. Microsoft Mouse and Keyboard Center
. Microsoft Office |
| Microsoft Office 2013

. Microsoft Silverlight

. Maozilla Firefox
) QuickTime -

1 Back
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Double click the Microsoft Office folder. The programs listed
inside of the folder will have the year of release as part of
the program name. Example: Microsoft Excel 2010 is the

2010 edition.

If the year is not listed as part of the program name, use the

following steps.

1

| ————————————
£ Windows Update &
< KPS Viewer l
) 7-Iip

. Accessories
CnpXpress
. CutePDF
. Google Chrome
J Java
. Maintenance
| Mchfee
. Microsoft Lync
. Micresoft Mouse and Keyboard Center
Microsoft Office
@ Microsoft Access 2010
(] Microsoft Excel 2010
m Microsoft InfoPath Designer 2010
m Microsoft InfoPath Filler 2010
@ Microsoft OneMNote 2010
0] Microsoft Outlock 2010
|E Microsoft PowerPoint 2010
|E Microsoft Project 2010
[B] Micrasoft Publisher 2010
@ Microsoft SharePoint Workspace 20]
[W] Microsoft Word 2010
. Microsoft Office 2010 Tools
. Microsoft Office 2013
. Microsoft Silverlight
. Motzilla Firefox
QuickTime
. RealMetworks

Back

IDENTIFY EXCEL 2003 AND PASSWORD-PROTECT

m

Office 2003 has text-based menus on the gray bar: File, Edit, View, Insert, Format, Tools, Table,
Window, and Help. (The screen shots are based on Word, but it works the same in Excel.)

e Click HELP >
ABOUT

e Inthe ABOUT
Dialog box, find
the version on
the top line.

UE Document1 - Microsoft Word

© File Edit View

(7) E : Mormal

Insert

Format Tools Table

v Times New Roman ~ 12 «

Window | Help

B 7

S S T S N S R R B

R

(=] B3
Type a question forhelp » X
@ Microsoft Office Word Help  F1 o
Microsoft Office Online 1 o (g
Contact Us -

Customer Feedback Options. ..

About Microsoft Office Word

¥
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About Microsoft Office Word

Microsoft® Office Word 2003 (11.8313.8221) 5P3 «
Part of Microsoft Office Professional Edition 2003
Copyright © 1983-2003 Microsoft Corporation. All rights reserved.

Portions of I ional C pell™ spelling ion system @ 1993 by Lemout & Hauspie Speech
Products N\, Al rights reserved. English thesaurus content dewveloped for Microsoft by Bloomsbury
Publishing Plc, French spelling checker, dictionaries, hyph tool, th and application © 1994-2000
SYNAPSE Développement, Toulouse (France). All rights reserved, Spanish Spelling Engine, Hyphenation
Engine, and Thesaurus Engine © 1998-2002 by SIGNUM Cia, Ltda. Quito, Ecuador. All rights reserved,
French and Spanish bilinqual dictionaries @ Langenscheidt KG Berlin and Munich 2000, Cettain templates
developed for Microsoft Corporation by Impressa Systems, Santa Rosa, California. Compare Versions
©1993-2000 Advanced Software, Inc, All rights resenved.The American Heritage Dictionary of the English
Language, Third Edition Copyright @ 1392 Houghton Mifflin Company. Electronic version licensed from
Lemout & Hauspie Speech Products N\, All rights reserved,

This product is licensed to:

Microsoft Corporation
Product ID:

View the End-User License Agreement

‘Warning: This computer program is protected by copyright law and international
treaties. Unauthorized reproduction or distribution of this program, or any portion of

it, may result in severe civil and criminal penalties, and will be prosecuted to the System Info... |

maximum extent possible under the law.
Tech Support... I
Disabled Items... |

PASSWORD PROTECT IN EXCEL 2003

Go to the FILE menu and click [} Microsoft Excel -

SAVE A

[, Im

Format Tools Data Window Hg

=]

—

Save As...

l Save Workspace...
%1 File Search...

Permission >

Web Page Preview

Blwlo|~o|o|&lw

Page Setup...
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Navigate to drive and/ or folder
where you plan to save the
document in the SAVE IN box
at the top. Enter the document
name and click OK.

From the TOOLS menu, click
OPTIONS.

Saveini | (L) My Documents v[|@ 8@ ¥ Cu E3 - Took-
\-_"ll'"h.' [rsic by
ety Pictures
My Recent |7ty Received Filas
[ocuments
[rerskbop
My Diocuments
Iy Computer
File nzme: _ 3 e
Ty Msbiwirk: I =4 ]
Places Save a5 tyPe: | Micrasoft Cffice Exeel Warkbook v

Error Chécking...

Shared Workspace...
Share Workbook...

Protection >

Online Collaboration »

Formula Auditing »

| ostons_____H
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Onthe SECURITY tab, type a
password in the field for
PASSWORD TO OPEN

: Opﬁons

View I Calculation

| General | Transition
Color | International

Save I Error Checking ]

File encryption settings f 00k

Edit
I

File sharing settings for this
Password to modify:

[7] rRead-only recommended

Digital Signatures...

Privacy options
[7] Remove wation from file properties on save
Macro securi

Adjust the st.\
specify names

IDENTIFY OFFICE 2007 AND PASSWORD PROTECT

(&
Office 2007 introduced tabs and the Microsoft Office Button o and a tab menu.

e Click the MICROSOFT — 1 T K
OFFICE BUTTON
(D'; T o Recent Documents
% > EXCEL L
OPTIONS. _‘; Doen

In the OPTIONS dialog
box, click RESOURCES. .
Find the version H SR ¥

",f Prepare  »
Z‘f Send  »

: et Publish »

._:\ Close 2

| 2] word Options | | X Exitword
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Word Options

(21

15 Contact Microsoft, find online resources, and maintain health and reliability of your Microsoft Office -

Check for Updates |
Diagnose I
ContactUs |

Popular
L9 programs.
Display
Proofing get updates
Save Get the latest updates available for Microsoft Office,
Typography run Microsoft Office Diagnostics
Advanced Diagnose and repair problems with your Microsoft Office programs,
Customize contact us
Add-Ins Let us knows if you need help, or how we can make Microsoft Office better,
Trust Center activate Microsoft Office
l [ Resources ] Activation Is required to continue using all the features In this product.
1 go to Microsoft Office Online

Get free product updates, help, and onling senvices at Migosort Office Online,
ahout Microsoft Office Word 2007 @
Microsoft® Office Word 2007 (12.0.6504,5000) SP2 MSONR2.0.6529.5000)

Activate |
Go Online I
About |

|

4

PASSWORD PROTECT IN EXCEL 2007

Click the
MICROSOFT
OFFICE Button

(Da
“WH > SAVE AS.

Use the down
arrow in the
address box (top)
to navigate to
where you plan to
save the
document. Enter
the document
name and click
Save.

@ Save As m
@l\__./l'| . ¥ Libraries » |D0cuments| h| Excel - | sy | | Search Excel 0 |
Organize = MNew folder == - @'

(] Microsoft Excel — Documents library , _
Arrange by:  Folder =
Excel
W Favorites | MName Type Size
4 Libraries Mo iterns match your search,
j] Documents B
J‘? Music
[E=] Pictures
B8 Videos
] www * 4| T | r
File name:  Mumbers.dsx -
Save as type: [Excel Workbook (*xlsx) -
Authors: Owner Tags: Add a tag
[[] 5ave Thumbnail
+ Hide Folders Tocols - Save l [ Cancel
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Click the
MICROSOFT
OFFICE button,
point to REPARE,
and then click
ENCRYPT
DOCUMENT.

&

MNew

) Iy

Open

Lave

Save A

Print

Prepare

send

Publish

L We N@&ETY

Clase

L]

Prepare the document for distribution

g o B2 e

Properties
View and edit workbook properties, such
as Title, Authaor, and Keywards.

Inspect Dooument

Check the wworkbook for hidden metadata
or persanal information.

Encrypl Docuiment

Increase the sequrity of the workbook by
adding encryption. %
Restrict Permission

Grant people access while restricting their ¥
ability to edit, copy, and print.

Add a Digital Signature

Emsure the integrity of the workbook by
adding an invisible digital signature,

Mark xs Final

Let readers know the woarkbook is final and
make it read-only.

Run Compatibility Checker
Check for features not supported by earlier
versigns of Excel,

] Excel Optjons ][K Exit Excel

In the Password box, type the password and click OK
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IDENTIFY OFFICE 2010

Office 2010 introduces the FILE tab and the Microsoft Office Backstage view

Click FILE > HELP L 9= 155
1 ne Insert Page Layout References Mailings

Under PRODUCT i save
. Support
ACTIVATED, find the ) save As
. i e Microsoft Office Help
version. [J Open
(4 close lig  Getting Started
Info @ Contact Us
Recent Tools for Working With Office
2z} Options
New
$1  Checkfor Updates
Print
Save & Send
2
2] Options
E3 ext

Review View Developer : 0

sa.Office

Product Activated

Microsoft Office Professional Plus 2010

This product contains Microsoft Access, Micros cel, Microsoft
SharePoint Workspace, Microsoft OneNote, Microsoft Outiook,
Microsoft PowerPeint, Microsoft Publisher, Microseoft Ward,
Microsoft InfoPath.

Change Product Key

About Microsoft Word

Version: (32-bit)

Additional Yersion and Copyright Information
Part of Microsoft Office Professional Plus 2010

& 2010 Microsoft Corporation. All nghts reserved.

Microsoft Customer Services and Support
Product ID:

Microsoft Software License Terms

B— |

See Password Protecting instructions on page # 30

OFFICE 2013 AND OFFICE 365

The latest version of Office still uses the File tab and the Microsoft Office Backstage View.

e Click File > Account

. . Account
Under Product Information, find -
the Version Liser Inkormaiion
Qe B kg
Ofice Therre

Comnecied Seraices

b e

Jdoasdoone

] Office

Pradiuct
I'.1 rroact

ACtnaled
e Frodesonal #in XL II

Abou Word
L LT .

See Password Protecting instructions on page # 30
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PASSWORD PROTECT IN EXCEL 2010, 2013 AND OFFICE 365

Click FILE > SAVE AS. Use [X] Save As .
the down arrow in the address @l\:jv| . v Libraries » |D0cuments| >| Excel - | (r¢| | Search Excel ol
box (top) to navigate to where Organize v New folder = @
you plan to save the (%] Microsoft Excel ~ Documents library 3 )
Arrange by:  Folder =
document. Enter the e
. [ Favorites L - . .
document name. Do not click = Name Type size
Save yet_ 4 Libraries MNa items match your search,
;S] Documents Bl
J‘f Music
(=] Pictures
B Videos
] waw - 4 m ] 3

File name:  Mumbers.xlsx

Save as type: IExceI Workbook (*.xlsx) hd
Authors: Cwner Tags: Add atag
[7] Save Thumbnail
« Hide Folders Tools ~ Save ] [ Cancel

Click on TOOLS (bottom
right) > GENERAL OPTIONS

m [ Save J ’ Cancel ]

Map Metwork Drive...
Web Options...
General Options... [

, b
Compress Pictures...

In the PASSWORD TO OPEN Gereral Options

box, type a password and
ypeap ("] Always create backup

click OK. File sharing
Password to open: oooooooool
Password to modify:
["] Read-only recommended

[ OK ] [ Cancel

Click Save

You will need to remember your password. If you write it down, keep it in a secure location. A best practice is to write down a

password hint rather than the actual password.
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3E’S OF HEALTHY LIVING —
EDUCATION, EXERCISE AND EATING RIGHT

The U.S Department of Agriculture prohibits discrimination against its customers, employees, and
applicants for employment on the bases of race, color, national origin, age, disability, sex, gender identity,
religion, reprisal, and where applicable, political beliefs, marital status, familial or parental status, sexual
orientation, or all or part of an individual’s income is derived from any public assistance program, or
protected genetic information in employment or in any program or activity conducted or funded by the
Department. (Not all prohibited bases will apply to all programs and/or employment activities.)

If you wish to file a Civil Rights program complaint of discrimination, complete the USDA Program
Discrimination Complaint Form, found online at http://www.ascr.usda.gov/complaint _filing cust.html, or at
any USDA office, or call (866) 632-9992 to request the form. You may also write a letter containing all of the

information requested in the form. Send your completed complaint form or letter to us by mail at U.S.
Department of Agriculture, Director, Office of Adjudication, 1400 Independence Avenue, S.W., Washington,
D.C. 20250-9410, by fax (202) 690-7442 or email at program.intake@usda.gov.

Individuals who are deaf, hard of hearing or have speech disabilities may contact USDA through the Federal
Relay Service at (800) 877-8339; or (800) 845-6136 (Spanish).

USDA is an equal opportunity provider and employer.
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http://www.ocio.usda.gov/sites/default/files/docs/2012/Complain_combined_6_8_12.pdf
http://www.ocio.usda.gov/sites/default/files/docs/2012/Complain_combined_6_8_12.pdf
http://www.ascr.usda.gov/complaint_filing_cust.html
mailto:program.intake@usda.gov

